Academic

Computing @
Beginning FileMaker Pro Support i==any

Information Technology Services

Version: 4.1 Tennessee Technological University
February 2000

Introduction

FileMaker Pro is a database program that can help you to organize information such as accounts,

inventories, or personnel data. It is a flexible program that can work with one file or many relational
files.

Basic Database Terms

Database: A system of one or more files to keep information in an organized manner. A database
allows you to add, edit, delete, sort and search for specific information, and create and print
summary reports. In this exercise, the database created will consist of just one file.

Record:  All the information for one unit, such as an individual, a requisition, or an item.

Field: The storage location for information. Within a record, each piece of information is stored
in a specific field, such as name, address, and phone number for an individual.

Field Definitions: The characteristics of the field, such as type of data that may be entered. Fields may
consist of text or numeric information as well as other types such as dates or calculations.

Value: The actual information in a specific field.

Planning the Database

In creating a new database, the most important step is planning and considering what you want to be
able to do. Take your time with this step. Sketch out your ideas and share them with others. The
answers to these questions will help determine what you can and cannot accomplish with your data-
base. You will need to consider:

What is the smallest unit you want information on? For example, do you want to have information on
each class or on each individual in the class? Each record will hold information on this unit.

What pieces of information do you need to keep? Be practical and think about what you have time to
deal with. Also consider how you will keep track of changes in the information. How will you know?
These pieces of information will be your fields.
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Planning the Database (cont.)

In what form should you store the information (numbers, text, dates)? You should store numbers that
are not used in computations (+,-,*,/) as text fields. For example, you wouldn’t add telephone num-
bers or zip codes, so those should be stored as text.

Which specific fields do you need? For example, do you want just a Name field or do you want a First
Name and Last Name field so that sorting can be done alphabetically by last name. These decisions
can affect the kinds of reports you will be able to produce.

Can the information be stored in one database (flat) or are there several databases needed that will be
linked together (relational)? For example, if you are doing requisitions, you might want a second file
with the names and address of vendors to be able to link into the file containing each requisition.

In this exercise, we will create a database with one file to keep track of a departmental inventory.

Opening FileMaker Pro

To open FileMaker Pro: Start = Programs — FileMaker Pro 4.1 = FileMaker Pro

Note that in the FileMaker Pro 4.1 subdirectory in your office you may select FileMaker Pro Tutorial.
This provides some basic information on FileMaker Pro that you can go through at your own pace.

Creating a Database from a Template

In the New Database dialog box:

New Database

* Click on

@® Create a new file @

* From the pulldown
menu, select:

Pulldown menun

Education
Education. & Create a new file using a template:
cerificates ﬂ
event schudule
¢ Double-click on " Create a new empty file... faculty staft
field trips
faculty staff to open a Loans
template to create a staff SRBrEnCun]
student records
database. to do list
Note: For more information
on each template, click on the | | Nelengershow this dislag [ |

Template Info... button.

For more information
Template Info... ﬂ‘/ QK I Cancel |
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Creating a Database from a Template (cont.)

* A dialog box will open asking you to create a copy of the file.

* Select the temp drive for this class; otherwise, select a permanent folder location.
* For this exercise, accept the name suggested.

* Click Save.

You will now see a database set up to keep track of employee information.
» To create a new record to enter data, click on the button New Record.
* Type in information on yourself and tab to move from field to field.

Note: You can make changes to the design and layout of this database, since this is a copy based on
the original template. Select Mode — Layout.

To close this file, from the menu select: File = Close.

Creating a New Database File

In creating a database of items in a departmental inventory, consider some of the fields that will be
needed, such as the kind of item, a description of it, the cost and date received, etc. List these ahead
of time.

* From the menu select, File > New

¢ Click on @ Create a new empty file

* Click OK.
In the Create New File .dlalog qu: 1 feldie) Viewby [ croaton order =]
* Select the temp drive for this exer- | g4 ame Tvoe Options
cise; otherwise, select a permanent
location ¢ ltem Description Text
# ltem Location Tent
* Type the filename: # Item Cost Murmber
Dept Inventory ¢ Date Received Date
. ¢ Account Mumber  Text
* Click Save. + Serial Mumber Text
¢+ TTU Tag Tent
. . . ¢ Assigned To Tent
In the Deﬁne.FleldS dialog box: ¢ [tem Age Calculation = (Today- Date Received) /365
* Under Field Name, type: + Comments Text
Item Category
* Select the field Type ©® Text |
» Click Create. K 4
* Type the next field name shown in | FieldName |
the list here (Item Description), se- | [ T¥re
) , Creat Options... I
lecting the field type @ Text ' Text  Container 0= | e
* Click Create. ¢ Number " Calculation N | Duplicate |
" Date = Summary
" Time  Global Delet ]
Enter the next 7 fields as shown above: o | o |
Note the field type for:
Item Cost ® Number (See the next page to enter Item Age.)

Date Received @ Date
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Creating a New Database File (cont.)

To enter a calculation field:

* Type the field name Item Age
¢ Select ® Calculation as the Type and click Create.

Formula to enter:
(Today - Date Received)/365

 The Specify Calculation dialog box will appear.

» To compute the item age, click in the formula box and type a left parenthesis (
* In the list of functions to the right, scroll down and double-click on the function Today

* Click on the subtraction symbol button. |:|

¢ In the list of field names to the left side, double-click on the field Date Received.

* Click in the formula box and type a right parenthesis )

* Click Onbthe division Specify Calculation il
symbol button. | /
Ty pe 365 I Current File ("Deptlnventury.FPS;I Operatars  iew I all by name ;I
L] y . - -
[tern Category - = - Tan (number) -
[tern Description & | / | <« TextToDate (text) J
[tern Location ol T > TextToMum (text)
N hat th lculati ltern Cost | | < TextToTime (text)
ote that the calculation Date Received P _ 3= Time ( hours, minutes , seconds )
result is correctly listed gcqom Nugnber _| _| e | TimeToText (time )
as Number in the U Tag o +| o (o 1
pulldown menu. ItASSEHEd To -| xar w| |Truncate (number, precision)
Brm Age =

* Click OK.

(Today - Date Recered)/365

* Enter the last field
name: Comments

» Type: @ Text

* Click Create.

* Click Done.

izalculation resultis Mumber / ;l

[ Repesting field with & maximum of

¥ Do not evaluate if all referenced fields are empty

Field Types Available

|2 walues

B

[~

Storage Options.. |

(0] I Cancel |

Field Type Data Type

Text Up to 64,000 characters (letters or numbers) used as text. Sorts alphabetically.
Number Up to 255 digits. Can be used in formulas. Sorts in numerical order.

Date Dates including month, day, year. Sorts chronologically.

Time Time in hours, minutes, or seconds.

Container Graphics, sounds, QuickTime movie, or OLE object.

Calculation Results of a formula which may be text, number, date, time, or container.

Summary Summary of other values, such as totals, counts, or averages.

Global One value to be used in all records which can be text, number, date, time, or container.
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Modes

FileMaker Pro includes four modes for working in your database:

* Browse - for data entry and general viewing of your data.

* Layout - for designing how your information will appear on the screen and in reports.

Find - to locate a particular record or set of records.

* Preview - to see on your screen how information will look when printed.

Working with Layouts

You will see a basic layout of your fields created by FileMaker Pro. Note in the menu under Mode,
that you are in browse mode, ready to enter information. However, before beginning to enter data,
we will make some changes to this layout.

Layouts allow you to specify how you want your data to appear. You can easily modify and create

layouts to make data entry easier and to create reports.

Each database can have many layouts. A

layout does not affect how the data is stored, just how it appears on the screen or when printing.

FileMaker Pro creates the first layout, a Standard style layout, which includes all of the fields. This

layout is automatically given the name, Layout #1 (see below).

E3i Filemaker Pro

Graphic Ruler

File Edit Mode Show Arrange  Format  Script Window  Help
B pept Inventory.FP3
L Layout #1 v| Atial -| 8 :'I EILIEI ElE;|§| t|t|2]+]| in
e T R N T N N E R N E N N N
Layout Name 1
e — Header | : : : : :
| E nm-.l:anennrr ltem. Catedarn
I 1=\ kem Descrigtion TV oo —————— P
Layouts: ] © em Lo ~tem Location
] : © mem Cost - [llem Cost -]
] Date Received ~ |Date Received
M ANl oo el oo 1100 1 ————
I:I|CJ =1 = Serial Number - [Sarial Mumbear
Pointer Tool ®= |t |3 TIU Tag - [TV T
: Aesigned To ~ |ASSigned.To
R kemsge temofge..] o oo
] CGamments.
| J-Bodv i
—| Footer
1 =
o P g =
3 H: 1 pt
4
/
Status Area

To switch from Browse mode
to Layout mode, select:
* Mode = Layout

To set editing guides, select:
* Show — Text Ruler
* Show = Graphic Rulers
* Show — Ruler Lines
* Arrange —> Autogrid
(Click to deselect — no check
mark)

Three parts are shown:
Header, Body, Footer.

Each part can be expanded,
reduced, or even deleted.
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Working with Layouts (cont.)

Adjust the view:

* Click on Part Label Control button at the bot-
tom left corner to move the part labels off to
the side.

* Click on the increase size E Zoom Control
to change your view to 150%. (In the PC Lab
leave the zoom at 100% for better viewing).

Zoom Control

100 |afut| B ] 2| Layout = +| 4 Scroll Bar

Status Area Control

Delete the footer since it will not be needed in this layout:
* Click on the part label Footer.
* Press the Delete key on the keyboard.

Increase the size of the Header region:

* Click on the line separating the header from the body.

* Your cursor will change to a double arrow.

* Drag this border down to the 1 inch mark on the graphic ruler.

-

Increase the size of the Body region:
¢ Scroll down and click on the bottom line of the Body section.
* Your cursor will change to a double arrow.
* Drag this border down to the 6 inch mark on the graphic ruler.

Increase the readability of the layout:

* From the menu, select Edit = Select Al  (Note that the pointer tool button is depressed.)

* On the text ruler, select 12 point for the text size.

* Click in the center of the selected group and drag to move the group so that the tags are about
1 inch from the left side and the top is at 1.25 inches. Nofte the rulers are highlighted as you
move to help you position the group.

* Click elsewhere on the layout to deselect the fields and tags.

* Click on the label “Comments” and drag it to the right side.

* Click on the field named Comments and drag it under the tag.

* Click on the bottom right corner of the field to drag and resize it to fit under the Comments tag.

* Click on the label Item Age and hold the shift key down while clicking on the field Item Age.
* Drag these down to about 4.5

inches.
* Click elsewhere to deselect.

ItemECus1
%Lﬂleahgw AC[;:L?“ R;E:a:t:i(: zgg.gﬁ?iﬂ\;ﬁger
* Select the list of field names by | serialNumber [Eetialbumber ] [
clicking on each while holding the TTUTag [[T4.Tag
shift key down. Assigned To & m.nEd To
« From the menu select: | o
Arrange = Set Alignment. : :
Iterﬁ Age TIIE!IHTQET

Item Catégury
Item Description
Item Location

rI‘cem Category

Comments

{tem Description_:

Ttem Location

Commer:

Information Technology Services
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Working with Layouts (cont.)

To set the alignment of items (cont.):

* Under Top to Bottom, select
® Distribute Space

* Under Left to Right, select
® Align left edges

* Click OK. Note that the fields are now spread

out for better viewing.

* Click elsewhere to deselect the group.
* Select the list of labels by clicking on each
while holding the shift key down.

* From the menu select:
Arrange = Set Alignment.

* Under Top to Bottom, select
@ Distribute Space

* Under Left to Right, select
® Align right edges

* Click OK.

To set the items off using a box. color, and borders:

Set Alignment x|

— Top to Bottormn

" Mone
" Aligntop edges
" Align centers

* Distribute space

" Align bottom edges " Align right edges

—Leftto Right

" Mone
+ Align left edges
" Align centers

" Distribute space

* Select the drawing tool that is a rounded square.

* Note that your curser becomes a plus. +
* Place the plus at the top left corner of the items and drag diagonally to draw a box.
* Release at the bottom right corner just beyond the last field.
» The box appears as a layer on top of the layer containing the fields and field labels.

* With the box still selected,

—Sample
I
[ ]
D Ok | Cancel
hA
EEE
® | i

from the menu: i o
Arrange - Send to Back Item Category [ltern Categary | Comments
ttem Description [ltern Description | [“nmment
w . With the box still selected, ttem Location [tz Location |
) click on the: {tem Cost
vz da- Fill Color button. Date Received [Qate Renaived......
[} H: 1ot ‘| Account Number [&ccountNumber |
Serial Number [Serial Number |
» Select llght yellow. TTUTag [TT..Tag |
* Click elsewhere to deselect. Assigned To [AasignedTn |
tem Age
¢ Click on the fields while hold- | * - -
ing the shift key down to select them. Field Borders for selected objects
* Click on the Fill Color button and select white. Eeld Bordars
o With the fields still selected, select Format = Field Borders
* Check Top, Left, Bottom, Right and click OK. W Top v Left
* Click elsewhere to deselect the fields. v Bottarn v Right
Information Technology Services February 2000
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Working with Layouts (cont.)

To add a heading:

* Click on the text button (A) in the toolbar and your curser changes to an I-beam.

el A - c . .
* Click in the header region and a text box will appear.

e Select the font Arial and a font size 18

% [ ] ’ i - - EI = El El
* Click on the Bold button. .Anal 15 -] 18 2 4]

IDI|I|I|I|1I|I|I|I|2I|I|I|J\

* Click on Center alignment :
'Departmental Inventory]

* Type: Departmental Inventory.

* Click outside the text box to deselect text entry.
* Click on the text box and move it to the upper left corner of the page.

* Click on the lower right corner and drag to expand the text box to the right margin line.
* Note how the heading is now centered across the page.

RIINE

Header

To add the current date under the heading:

¢ Click in the heading region and set the font size to 12.

* From the menu, select Edit = Paste Special = Date Symbol (Looks like two slashes //).
* Click outside the text box to deselect text entry mode.

* Click and drag to position the current date.

To format the date: Date Format for selected objects

" Leave date formatted as entered

¢ Click on the date symbol (//) to select it.
* From the menu, select Format = Date

& Format as: 1242541997

12/25/1397
* @ Format as: and select the style you prefer. Dec 25,1997
¢ Click OK. & Custorm: December 25, 1997

Thu, Dec 25, 19497
Thursday, December 25, 1997

To add text in the body:

* Click on the text button (A).

* Move to the end of Item Age and click.
* Select a font size of 12 and a Left alignment. ltem Age
* Type: Years

* Click outside the text box to deselect the text button

* Click on the word Years and drag to adjust the position as needed.

To format the number of decimals displayed:

* Click on the Item Age field.

* From the menu, select Format &> Number @ Format as decimal number

* @ Format as decimal number ¥ Fixed number of decimal digits: |1
e M Fixed number of decimal digits: 1

 Click OK.
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Working with Layouts (cont.)

To set currency formatting:

* Click on the field Item Cost.

* From the menu, select:
Format > Number

* Select:

® Format as decimal num-
ber

M Fixed number of decimal
digits: 2

M Use notation:

Currency (leading)
Currency symbol: $
M Use thousands separator

* Click OK.

Number Format for "Item Cost"

" Leawve data formatted as entered

" Format as Boalean

Show RONFZEr0ES 85 'as
& Format as decimal number

¥ Fixed number of decimal digits:

¥ Use notation:

Currency |

[ Do not display number if zero

— Separators

Show eernes as: IND

|2
Currency symbol: |$

Decimal separator: I

¥ Use thousands separator:

[

MNegative

Format as: -1234 -
[~ Use colar; lvl -

— Sample

-§6,543.99

Text Format... |

o |

Cancel |

To format a field with radio button:

» Select the field Account Number
» Select Format = Field Format
» Select Radio buttons from the

pulldown menu.

» Select Define Value Lists from the

pulldown menu.

¢ Type the name Account Numbers in Value

List Name.
Click Create.

Click Save.
Click Done.
Click OK.

Select ® Use custom values:
Type three account numbers in the box. Be
sure to press enter afier you type each one.

fe I Radio buttons

- | using walue list

™ Include "Other.." itern to allow entry of ot

I~ Include "Edit.."item to allow editing| of w2

Define alue Lists... ;I
<MoLists Defined>

Defing Walue Lists..

Yalue List Mame

¢+ Account Mumbers

& Lse custom values:

Each value must be separated
by & carriage return.

S e |

1 walue list(s)

2-95765
512345
11221

Information Technology Services
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Working with Layouts (cont.)

To format a field with a Pop-up List:

* Select the field Item Category

* Select Format = Field Format

* Select Pop-up List from the pulldown menu.

* Select Define Value Lists from the pulldown menu.
* Type the name Item Category in Value List Name.

* Click Create. Value List Name

¢ Select ® Use custom values:

* Type the categories shown. — # Use custom values: Books
: i

* Click Save. Each walue must be separated _ aens

* Click Done. by a camage return. Computers
. Equi t

* Click OK. Add a divider by entering a _ Huipmen

hyphen "-" an a line by itself. Misc.

To add a graphic image to the layout:

* From the menu, select File = Import Picture
* Browse to ClassFiles on Athena = ITS Folder = FileMaker Pro

* Select the file: Folders. WMF Graphic Format for selected objects
Note that the graphic is rather large. [Fec — sl _

» With the graphic still selected, e B
from the menu select Format = Graphic. ¥ hdaintain ariginal propodions

M Maintain original proportions. Alignment | Let =] [Top =

* Click OK.
* Click on the lower right corner of the the graphic and drag to decrease the size and move it to the
right of Departmental Inventory in the header.

Working in Browse Mode

Use Browse mode to enter new information and correct existing data.
From the menu, select Mode = Browse

To enter a new record:

Select Mode = New Record or use the keyboard shortcut, Ctrl + N
Type in the data shown here.

lterm Categaory tern Description  Iterm Locatian ltern Cost Date Received Account Serial Mumber TTU Tag Assigned To
Murmber
Computers Dell Dimension BR 388 15849 972997 2-98765 8989888 0123122 Dr. Sue Jones

Use the tab key to move from field to field.
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Working in Browse Mode (cont.)

Import some sample data from an existing file:

* Select File = Import/Export = Import Records
* Browse to Classfiles on Athena = ITS = FileMaker Pro
* Select SampleData.FP3

* From the pulldown menu, select View by: Matching Names |

* Select ® Add new records [ TP
* Click Import " Replace datain current found set

Move through the records by clicking on the book icon or using the slide along the edge
of the book icon.

Make corrections to records by editing any field.
To duplicate a record: Mode = Duplicate Record

To delete a record(s): Mode = Delete Record or Mode = Delete All (Use carefully).
To omit record(s) from the current set, but retain them in the database: Select > Omit

Data Entry v|

Move

Select = Omit Multiple

Using Find Mode

Use Find Mode to locate a particular record or sets of records that match your criteria.

* Select Mode = Find

* Select Videos from the Item Category menu.

* Press Enter or click the Find button to the left.
* Note that you have found the videos.

To find all records except videos:

* From the menu, Select > Modify Last Find
* Check Omit.
* Press Enter or click the Find button. Symbols v |

* Note that you have found all but the videos.

¥ Omit

To find records with items over 1 vear old:

 Select Mode = Find

* Click into the field Item Age.

* Click on the symbols pulldown menu and select > greater than
* Type 1 (for 1 year).

* Press Enter or click the Find button.
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Using Find Mode (cont.)

To find records with items purchased between 1995 and 1998:
* Select Mode — Find
* Click into the field Date Received.
* Type 1/1/95...12/31/98 (Use three periods to denote a range of values.)
* Press Enter or click the Find button.

To find records with missing or blank data in a field:
* Select Mode = Find
* Click into the field TTU Tag.
* Type = (Use = with nothing following it to indicate a match to a blank field.)
* Press Enter or click the Find button.

To find records with Computers paid out of account 5-12345 (And):
 Select Mode = Find
* Click into the field Item Category and select Computers.
* Click into the field Account Number and select 5-12345.
* Press Enter or click the Find button. (Note we are looking for this and that.)

To find records with Computers or Equipment paid out of account 5-12345 (Or):
 Select Mode = Find
* Click into the field Item Category and select Computers.
* Click into the field Account Number and select 5-12345.
» Select Mode = New Request
* Click into the field Item Category and select Equipment.
* Click into the field Account Number and select 5-12345.
* Press Enter or click the Find button.
(Note we are looking for this and that or the other and that.)

From the menu, Select = Find All to return to viewing your full set of records.

Sort Records x|

| Current File ("Deptlnventn;l Sart Order

Sorting Records

. ] jory Clear All | ¢ Account Mumber al =
To sort records: ltern Description — + ltem Category il _I
* Select Mode — Sort ltem Location
« Click on A t Number in the list | | 2"
1CK On Accoun umper 1 the 11S Date Received
to the left. Account Mumber Sart
. Serial Number
. Cl}ck on Move. TTU Tag G
* Click on Item Category. Assigned To | 4|
e Click M Comments D
1CK On ove. ‘ ltem Age LI ong | LI
* Note that the sort will be |  Includle summary fields
® Ascending order. al @ Ascending order
¢ Click Sort. h. © Descending arder
(Use Done to cancel without Sorting.) i Custom order based on value list I ltermn Categary ;I
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Creating a Report

To create a report that lists records by account number and sums the costs.

* Select Mode = Layout

* Select Mode = New Layout

* Type the layout name: List by Account

¢ Select ® Extended columnar as the Type

 Click OK !

* Select Item Description. | Current File ("DeptInvento ~ | Field Order
* Click on the Move button to move | o Criegory =] | s Movas | [+ Tem Desoripton =
it to the Field Order list. ltern Dascription 4| + ltem Cast
ltern Locati
« Select Item Cost. Elt |:::.: TR |
* Click on the Move button to move | |Date Received —_——
) ) ) A t Mumb |
it to the Field Order list. orol My
 Click OK. TTU Tag
Assigned To
tern Age Cancel
* Select Mode = Part Setup Comments hd | =]

* Click on the Create button.
* Choose ® Subsummary when sorted by.
» Select Account Number from the field list.

. (e Bad lerm oSt
e Click OK. e Date Feceived
. . 0 - " s Account Mumber
+ Choose Print Above (leading). 9 STt A S a7 ’””“Hr
¢ Click on the Create button again. " Trailing Grand Summary TTU Tauy

* Choose ® Subsummary when sorted by
. Se}ect Account Number from the field list. CTick on the Part Label Control 1o
* Click OK. view the full names of each section.
* Choose Print Below (trailing). Click again to hide them.

* Click Done.

* Click on the Field button to the left FEigld...
* Drag it into the Account Number Subsummary that is above the body
¢ Select the Account Number field.
» Deselect create field label.

¢ Click OK. Field Name ITDtal Cost
* Click on the Underline format button. Type
& Text " Container
Create a new field to sum amounts: ; E”:”ber ; ga":u'aﬂc'”
» Select File & Define = Fields e T.ae o Ty
. ime Glabal
* Type the Field Name: Total Cost
« Select the Type: @ Summa Tern Categary
yp ry & Total of ltem Description
» Select @ Total of - rverne o tern Location
» Select Item Cost from the field list. 2 E"' '3'5‘- -
. ale Receive
* Click OK. ® Counio Account Numkber

* Click Done.
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Creating a Report (cont.)

To add fields to the layout:

* Note that new fields created are added to the body of the layout you are currently in.

* Increase the size of the trailing Sub-summary by Account Number by clicking on the line and
dragging down.

* Select the new Total Cost field and label and drag them into the trailing Account Number Sub-
summary.

* Decrease the size of the Body section by clicking on the boundary line and it dragging up.

* Click on the Line tool.
* Draw a horizontal line above the Total Cost label and field by holding down the shift key while

o [V

e 0]
— 0 [ =

drawing your line. This will keep the line level. Shift, then click on the spot you want to begin

your line, drag across, release the mouse button, then release the shift key.

* Click on the Text tool (A).

* Click into the Heading section.

* Select font size of 18 and align center.

* Type: Departmental Inventory by Account Number
* Move and size the title text appropriately.

To view the report:

* Select Mode = Browse

* Select Mode = Sort

* Select Item Category and click the Clear button. This leaves Account Number as the field on
which to sort.

* Click Sort.

* Select Mode = Preview.
(Note that you can not see the resulting report unless you are in Preview mode.)

To print: Select File = Print to print the report. (Please do not do this during the class session.)

To exit the program: Select File = Exit or use the close button.
Note that the file is saved automatically at exit and periodically throughout your work.

Getting Help

One of the easiest ways to get help with FileMaker Pro is the online help included with it. Just click
on Help = FileMaker Help Topics

Should you have a question that the online help does not address, please contact the Microcomputer
Support Office at 372-6315 (email: MicroSupport@tntech.edu) or your college contact.

Handouts on using FileMaker Pro and other programs are available on the web from the TTU home
page under Computing = Publications (at www2.tntech.edu/its/pubs/).
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Final Views of the Layouts

Departmental Inventory

(r—'_r‘r__J,-_

Item Category [Books

Comments

Item Description |Calculus for Engineers

Item Location |CH 311

Item Cost[$0 00

Date Received [1/20/2000 |

Account Number |[52-93765 O5-12345 (O 5-11221

Serial Number |

TTU Tag |

Assigned Te |Dr.Sam Smith

Item Age Years

Free Desk Copy

Departmental Inventory by Account Number
ftern Description fern Cost
Calculus for Engineers $0.00

Total Cost §0.00

208765
Dell Dimension $1,5858.00
Dell Dimension $1,3858.00
Overhead Projectar $1,148.00
The Life of Albernt Einstein $59.00
All About Quarks F127.00
Total Cost F4,312.00

511221
Computational Theory §849.00
YCR and T $635.00
Totsl Cost §728.00

5-12345
Dell Cptiplex $1.,899.00
Slide Projectar $789.00
Total Cost $2.688.00
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